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Firmware Upload Tool and Device Software Upgrade and I nstallation

1.0 Introduction

Digital
Matrix
Intercom

and Guide

Application Note

This document provides the user information related to the installation and usage of the FWUT (Firmware
Upgrade Tool). FWUT is used for upgrading the firmware on the RTS-OMNEO devices. FWUT supports
firmware upgrade for the following RTS-OMNEO devices

Nr. Device Description Displayed in FWUT
OMI OMNEO Matrix Interface card. OMI Tab
OKI OMNEO Keypanel Interface card. Thisisthe option OKI Tab
interface card used with KP-32 CLD, KP-12 CLD, KP-32
Classic and RP-1000.
3 OEl-2 OMNEO External Interface box. Thisbox is used to provide | OEI-2 Tab
an OMNEQ interface to legacy keypanels.
4 OKP The new KP Series keypanels with a built-in OMNEO OKP Tab
interface. Thisincludes all KP Series models.
5 OAP Upcoming Access Point devices used with ROAMEO OAPTab
beltpacks (BP)
NOTE: The ROAMEO beltpack firmware is not supported
by FWUT. However, the beltpack firmware can be
uploaded viathe USB port on the beltpack.
6 ARNI Audio Routed Network Interface ARNI-E/S

ARNI-S (standard)
ARNI-E (enterprise)
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2.0 FWUT Information

IMPORTANT: Verify the FWUT and the device upgrade files are installed on the PC or laptop before upgrading
the firmware to the RTS-OMNEO devices.

2.1 Installation Files

The FWUT and the device upgrade files are avail able with the OMNEO Suitein the following folder at
\OMNEOSuite<V.x.x>\Packages\.

The FWUT folder contains installation files for both 64- and 32-bit systems. Appropriate setup files
must be chosen for installation.

Use Table 1 to determine the proper setup files needed to upgrade the RTS-OMNEO devices.

TABLE 1. Setup Files

Nr. File Name Description

1 iestiupOM NEOFirmwareUploadTool 64. This setup installs the FWUT tool utility.

5 SetupOMNEON i osFirmwareé4.ms Thissetup installsfilesrequired for OMI firmware
upgrade.

3 SetupOMNEOOEI 2Firmwareé4.ms Thls setup installs files required for OEI-2
firmware upgrade.

4 SetupOMNEOOK PFirmware64.ms Thls setup installs files required for KP Series
firmware upgrade.

5 SetupOMNEOOA PFirmware64.msi This setup installs files required for Access Point

(currently unavailable) firmware upgrade.

6 SetupOMNEOA i Firmware64.msi Thls setup installs files required for ARNI
firmware upgrade.
This setup installs files required for

7 SetupBoschDNS-SD Service64.msi Bosch DNS-SD service used for discovery of
devicesin the FWUT.

NOTE: The setup files for 32-bit systems do not have a 64 appended in the file name.

2.1.1 Installation Folder

The FWUT setup files areinstalled under the following folder on the PC/Laptop:
C:\Program Files\BOSCH\OMNEO\Firmware Upload Tool

The following sub-folder contains the FWUT files related to the devices (OMI, OKI, OEI-2,
KP-Series...):

C:\Program Files\BOSCH\OMNEO\Firmware Upload Tool\Upload Plugins




2.1.2 Ingstallation Seps

There are two options for installing the setup files:

Option 1 (Recommended) Run the Setup.exein the OMNEO Suite package.
The OMNEO Setup (OCA) window appears.

-

OMMNEQ Setup (OCA)

Please select the applications you wish to install:
R ' s [T AZedit vs.2.1 (with support for OMNEC devices)
[T 1Pedit ¥3.3.2 (replaces RVOMedit and supports OMMED devices)

VinNEO
0 vl [~ USE Driver for AZedit ¥1.0.0 {required for ZEUS-III or Cronus USE connections)

Software Suite
: (r

OMMED Firmware Upload Tool V4,40 {required for OMMEQ firmware upgrades) )

[~ ARNI Configuration Tool V4.40 {required for ARNI configuration)
[T EBosch DMS-50 Service Y440 irequired For OMMED Device Discovery)

This CD also indudes MCII-e and Keypanel firmware required for OMMED support,
as well as current versions of firmware for OMMEQ devices.

Open Firmware Folder View Readme. tt |

Install | Cancel I

Option 2 Manually install the individual setup files.

2.1.3 FWUT Usage

A helpfile, named FirmwareUploadTool.chm, isinstalled along with the FWUT file. It contains
information on the FWUT and its usage. It also hasinstructions on how to complete some of the
more necessary operational procedures, such as how to run the FWUT in advanced mode from a
command line.




2.2 FirmwareUp

grade

When the FWUT islaunched, it automatically displays all the RTSS-OMNEO devices discovered in the
system. The devices are listed on the separate tabs based on the Model ID. Use Table 2 to determine the
Model ID of the RTSSOMNEO devices and their user-identifiable names.

TABLE 2. Model ID Description

Nr. Model 1D Ach\i/lst)JI_qu_lggbon Description
1 2049 OMI-Audio Device | OMI-Audio Device
2 2050 OKI OKI
3 2051 OMI-Controller OMI-Controller Device
6 2060 OEl-2 OEl-2
7 2070 OKP K P Series (OMNEO keypanel) (OKP)
8 2080 OAP OMNEO Access Point (OAP)

2.2.1 Firmware Upgrade Files

NOoTE: FWUT only recognizes and supports files which have a .capfw extension. No other file

Each d

formats (mot, bin, hex) are supported.
evice has set of .capfw files used for upgrading the firmware.

The naming convention <DeviceName_Firmware Version>.capfw is used in naming the files.
Table 3 displays the currently released .capfw files for RTS-OMNEO devices. For more

inform

ation, see the individual device's release notes.

TABLE 3. Firmware Files

# | Device Firmware Files Description
OMI-Firmware RSTP_V6.x.x.capfw Firmware files which
OMI-Firmware noRSTP_V6.x.x.capfw upgrade the OMI card
OMI-Firmware AudioDevice RSTP_V6.x.x.capfw RArmware fileswhi Ch.
OMI- upgrade only the audio

1 oM Firmware AudioDevice noRSTP_V6.x.x.capfw ggrrgponent of the OMI
Firmware files which
OMI-Firmware_FPGA _0.75.capfw upgrade the FPGA on the
OMI card
> | oKl OKI-Firmware RSTP_V6.x.x.capfw Firmware files which
OKI-Firmware_noRSTP_V6.x.x.capfw upgrade the OKI card
3 | OFI2 OEIl-Firmware RSTP_V6.x.x.capfw Firmware files which
OEI-Firmware_noRSTP_V6.x.x.capfw upgrade the OEI-2 card
The following files give details for the different OKP (KP Series) firmware file. Each firmware
fileis used to update a particular component. Thisisto provide flexibility when there is only
one component to update.
RSTP version of firmware
. : and should be used to
4A | OKP_Audinate v5.xx.yyyy Client_v2.xx-OCA.capfw update all the KP Series
components




TABLE 3. Firmware Files

#

Device Firmware Files Description

4B

No RSTP version of

OKP_Audinate NORSTP_v5.xx.yyyy Client_v2.xx- firmware and should be

OCA .capfw

used to update all the KP
Series components

4C

OKP_Client_v2.x.x-OCA.capfw

Client Only firmwarefile.
There are no Dante
firmware files.

4D

OKP_Audinate v5.xx.yyyy.capfw

Dante component file,
thereisno client firmware
files.

4E

No RSTP Dante

OKP_Audinate NORSTP_v5.xx.yyyy.capfw component file. Thereis

no client firmware files.

4F

OKP FPGA v5.0.0.capfw

Thisfirmwarefile
contains the Intercom
FPGA component

NOTE: Refer to the KP Seriesrelease notesin case there is a change in the client or FPGA

image.

This section is specifically for the KP-series keypanels. Table 4 gives details about the files that
can be upgraded via AZEdit tool.

NOTE: The keypanel must be connected to Intercom via either an OMI card or A1O card.

TABLE 4. Firmware Upgrades

# Filename Description
Thisfile updates the “client” component of the
1 | KP-Series client_z v2.x.x-OCA.mot | KP-serieskey panels. It does not contain the

“Dante” component.

K P-Series-FPGA_v5.0.0.mot?

Thisfile contains the Intercom FPGA
component of the KP-series key panels. Thisis
not “Dante” component

K P-Series boot v1.3.0.mot2P?

Thisisthe firmware file for the boot loader of
the Keypanels. The boot |oader component
cannot be updated using the FWUT.

VM -chimes.mot

This file contains the default VVoice Mail
chimes.

V' M-icons.mot

Thisfile contains the default Voice Mail icons.

It is recommended to run the most current version of the boot loader and FPGA.
To check versions on the device, press and hold both shaft encoder s and then press the M enu button on the keypad. Ser-

vice menu appears.
Select Boot Code.

The Boot Code version appears on the panel display.




3.0 Migration from OCP to OCA

Beginning with V6.x.x, all RTSS-OMNEO device firmware has been migrated to the new OCA
Platform. Previous versions up to and including V5.2.12 have been discontinued.

V6.x.x provides following features

* Adjustable Receiver Latency

*  Switch between RSTP/no RSTP mode from | Pedit

»  Show audio connection status in 1Pedit between RTS-OMNEO devices and other
Dante devices

IMPORTANT: These instructions need to be followed exactly for a successful migration of the RTS-

OMNEQO devices. Refer to the release notes provided in the OMNEOSuiteV6.x.x for
details.

All devices in the system must be updated for devices to work with each other. OCA
devices cannot be used with non-OCA devices.

3.1 Mandatory Instruction

IMPORTANT: It is crucia to uninstall the existing FWUT package and reinstall the update.

1. Uninstall the existing version of the FWUT and its associated plug-ins.

a. From the Start Menu, select Control Panel | Programs.
b. Click Uninstall a program.

c. Uninstall the OMNEO FWUT, NIOS, OEI 2, and OKP Firmware packages.

| OMMEQ Firmware Upload Tool 64-bit V4.40.4085
| OMMNEQ NIOS Firmware 64-bit V4303712

| OMMEQ OEIL2 Firmware 64-bit V4.30.3711
|OMMNEQ OKP Firmware 64-bit V4.40.4086

| OMMEQ PC Tools 64-bit V4.40.4085

L R b B b B bl R il R




d. Verify the following directories are present and that they are empty. If there arefilesin the
directory, then delete them.

* C:\Program Files\Bosch\OMNEO\Firmware Upload Tool
* C:\Program Files\Bosch\OMNEO\Firmware Upload Tool\UploadPlugins
2. Using the latest version provided in the OMNEO Suite V6.1.x or higher, upgrade the FWUT and the
associated plug-ins.
NOTE: For the latest version of the OMNEO Suite, visit www.rtsintercoms.com.
3. Verify filesare present in the following directories:

a. C:\Program Files\Bosch\OMNEO\Firmware Upload Tool
«  OAPOCAFWUTProxy.dll
*  FpgaNiosFWUProxy.dll
e MCUFRWUTProxy.dil

b. C:\Program Files\Bosch\OMNEO\Firmware Upload Tool\UploadPlugins
» UploadFpgaNIOS.dll
e UploadOKPdIl
* UploadOEIl2.dll
4. Using the following graphics, determine the correct migration sequence and .capfw file to use.

IMPORTANT: To avoid firmware upgrade failures and incorrect firmware being installed on the devices, use the
illustration below lists the path for different devices.

OMI Device
Check Version
If you have: If you have: If you have:
firmware version firmware version FPGA version
5.2.1or 5.2.5 or older 5.2.12 or newer 0.48 or 0.50
First migrate l Then migrate l Then migrate l
to: firmware version to: firmware version to: FPGA version
5212 G.x.x 0.75

Then migrate l
to:

firmware version
G.x.x




OKI Device
Check Version

If you have:

firmware version
5.x.x

Then migrate l

to:

The following migration path determines the firmware files required for the KP Series panels.

firmware version
6.x.x

OEI-2 Device
Check Version

If you have:

firmware version
1.4.0

Then migrate l

to:

firmware version
2.X.X

Check KP Version

If you have:

firmware version
1.2.%

Then migrate l

to:

firmware version
2.X.X

If you have:

Then migrate l
to:

If you have:

FPGA version

boot loader version
1.2.0

Then migrate l

FPGA version to:

boot loader version
1.3x
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3.2 Exampleof Upgrade Seps

The following example shows upgrading OMI device, but this example is applicable for other device
types.
1. Openthe FWUT.

Bosch
IT Workplace Toolkit
. Developrment Kit
. OMMNED
, Docent
J Firrnware Upload Tool (84-bit)
) Firmware Upload Tool Documen
%Firmware Upload Tool
Licenses Firmware Upload Tool
Uninstall OMMED Firrware Uplc

Once the FWUT is opened it displays a list of devices (shown). If this displays, it means the image
folder path does not contain the firmware upgrade files (.capfw files).

[o, LY FITF—T=,
Bl Wl

QLMED Firrha/sdd Uplosd Tool

Leviem
e T il SRS | it SO0 | it POC | Wi R | Mt T

Cepram ey g =

E
3
FEFRE

2. From the File menu, select Options.
The Firmware Upload Tool Options window appears.

3. Enter theimage folder path which contain the .capfw file.
OR
Click the Change button to navigate to thefile.
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In this example the image path contains folder which has OMI .capfw files.

Firmware Upload Tool Options

Firmwane mages
Image folder E-\Firmware V6.1 10MOMI_Images
[¥] Include sub folders

Uploading
Madimum number of concument uploads 20 [R=
|"] Use secure connection
Security key defaul

Once the image folder path is set the FWUT displays the OMI tab which contains the discovered
OMI devices (shown).
From the OMI tab page, select the OM| device or devices.

Fle  View Help

OMMNEQ Firmware Upload Tool
I EEEEEEEEEE—————————————————————_—_————_—_——_—

Dieices
[ Model 2060 | Model 2050 | Model 2080 OM1 | Model 2070

Crwica namen Sarial ramber Finda F mddress WAL acidreas ‘ermon e Frogress
"TS (4SETE41A1AT01001 MAOIBIE  OOICLO0ES0E 6000010 idte

OML-SLOT-5TIM (455153305 10021006 WHOIETE  ORICH40EII GOTO00 e

S0T13 D4 5R2TSI3051500100% 10200108 83 OIC4400:8438 6010010 ke

HOTHH BaBE AN 1802100 MHOIEE OICA00REN & NLAI0 idle

ROTI? (4551533051001 116 WHNOIET  OICA00ELIC 601000 e

OMLSLOT-1000F £315342004111003 WHOIENI  ICH00E52 502002 iste

ONLELOT-8-0CP ST 1T 101008 WHOIEM  OICHOOBEC BR800 e




5. Click the Upload button.
The Select Firmware for upload window appears displaying a list of OMI .capfw files.

T e e e

Fa Ve Mg

[+
OMNED Firmware Upload Tool

-
Dwecen

| i 3005 | Mot 2050 | ol 08| % [ Mol 20 . B S .
Do rme it e Foie P sadrwss HA madeei " k)

AR RLOT- W00 TN T WECIWT WICAEE SEn L]
O ST 40P ST 8T 00 10200108 34 o0 hendhBaFC SEIDEAD L]

Vi ra
“Frmsmw' % 1 10080 imagen DAS-Femaws PG4, cacfe

B Frmny 7 1 108 Imsge 048-Femaws ol TF cgfs

1 Frmn 7% 1 1008 magees DA Famsrrs,_ RS TP ol

B Frmy 7% 1 1008 msgenr Dy Pl Pl S 173, s O S, PUb_ [ T8l
B P v | 10080 g By i N a0 gt DA PO it

6. From the Available firmware list, select the correct OM 1 .capfw file.
The Sart button activates.
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7. Click the Start button.
A progression bar displays showing the progress of the firmware upgrade.

Fie  Weew Help

OMNEQ Firmware Upload Tool
I —————————————————————————————__————_—_——_——
Corrces

[ Mool 2060 | Model 2050 | Mosel 2080 | OM1 | Mosel 2070

Drvae rires

RTS

O SLOT-E-TIM
AOTIZ

SOTH

Loty

D SLOT-10-0CF
Q- SLOT-B-DCP

Sefial rurmes
a1 R EINNI001
D4531933080002 1008
Dasa 1933051507 1005
Da53193305 15021000
4831933080002 1018
SR HOT
53193417008

1P address
00, 108178
D000, 108 73
0300 108 B3
B0L200. 108 22
D000, 108 74
L300, 108,113
50200, 108 M4

AT sodreas

o
o0
s
o
o0
o
1y

Bk 0 B50E
o 00 8423
MO0 E
L 00 B3
e 00 84:3C
M0 a5
L D0 B FC

Werson

6070010
6070010
E01.0070
6070010
607,010
S03omz
502002

b1 1]
]
el
]
=]
=]
L]

L]

11

The version string for 10 card in AZedit alternates between version and Firmware Download In

FIRMWARE DOWNLOAD IN PROGRESS

FIRMWARE DOWNLOAD IN PROGRESS

Progress (shown).
0oy n/a
010 n/a
011
012 n/a
013
014 n/a

The Sate column displays Finished.

L -

File  Weew Help

OMMEQ Firmware Upload Tool
I ——————————————S—S—S—S—S—S——S——S———————————
D

Mol 2060 | Moce 2060 | Mogel 2000 | OM1 | Model 2070

[

RTS
DMI-SLOT-5TiM
ROTH

SOTHI

SLOTHT
OMI-SLOT-80-00F
DMI-SLOT-8-0CF

Sonal rumbes

DaRE TR0
D53 1005 0006
D453 TR0 1500005
DaSE TS0 1 E0000
DASE NS 0N 06
SE1SD00ET 11003
SH1HITIN00G

P e

E0.200. 508, VB
0200 508 T8
S0L.200: 508 B3
60200 508 .20
0300 508 T4
0.200: 508113
5L 200 508 4

MAT aitesa

‘Veran

DO R DGES0E §01.0070

DO AL D a4 2T
DO 8L 42 DG 34T
DO 4L D034 10
D0 BT D 34 30
00 B4 D A5 24
00 B0 44 D34 FC

E21.000
S2.0000
E210070
2009
5030012
5820012

Sme

Firaahadl
Firaahad
Franbad
Firaahadl
Firanhad

(Hf}
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4.0 Troubleshooting Guide

Q1. | seethe device discovered in the FWUT, but when | select thefile and click update, it displays Failed
immediately.

Al.  Verify the IP Address of the PC/Laptop running FWUT isin the same subnet as the devices being
upgraded. Even though FWUT can discover devicesin other subnets, it will fail to connect.

A2.  Verify the correct adapter is selected when the FWUT is launched.

Plaase select & network intedsce to use

A3.  Verify two |P Addresses have not been assigned to the same adapter.
' Advanced TCP/IP Settin Lot S|

IF addresses
IP address Subreet mask
169.254.0. 250 255.255.0.0
192.168.0.250 255.255.255.0
[ ada.. |[ Edt. || memove |
Default gateways:
Gateway Meitric
| Add.

Q2. FWUT isin the same subnet asthe devices, but when | select the file and click update, nothing happens.

A2.  Verify the device upgrade files have been installed for that device.
Thesefiles are available in the following directory:
C:\Program Files\ BOSCH\OMNEO\Firmware Upload Tool\UploadPlugins
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Q3. How do| refresh the FWUT so it showsthe updated status?

A3.  From the File menu, select Options, and then click OK.

View  Help

Options..,
Bat  ARk+F4

Devices

The Options window appears.
Click OK.
The Options window closes.

Q4. How do | abort a Firmware upgrade to a device from the FWUT?

A4. The FWUT does not have an Abort button. Use the Windows Task Manager to force the Firmware
Upload Tool to close.

NOTE: All devices have afail-safe mechanism implemented in them.

Q5. | seethedevicein the FWUT, but when | select thefileand click update, it displays a green progress bar,
but then shows Failed after sometime.

A5.  Verify the TFTP ports/ application are blocked on the network or by the firewall.
FWUT uses TFTP to transfer filesto the devices.

Q6. How do | get additional information on why the upgrade to the device failed?

A6. FWUT logfiles are available in two places:

1. From the View menu, select L ogging.
The Logging window appears and displays the currently logged messages. The log messagesin this
window are lost when FWUT is closed.
OR
Navigate in Windows Explorer to C:\ProgramData\Bosch\OMNEO\FirmwareUploadL og.
Thisfolder containslog file. A new log file is created every time FWUT is opened. For trouble-
shooting the information in the log file is hel pful.

File | View | Help

Available firmware...
OM Devices in failsafe mode... F3 |
Bl | logging.. rol
Dev I/\gE|ECtCD|LIrTIFIS...
—

16



Q7.What isadvanced mode of the FWUT?

A7. Advanced mode of the FWUT is exactly same as the normal mode as far as the upgrade processis

concerned. In Advanced Mode, additional menu items are displayed. For more information, see the
FWUT helpfile.

File ‘-fieu\% Help

how all components

OM Available uploaders... I
Available firmware...

Dev Devices in failsafe mode.. F3

Legging... F4

Select columns...

Q8. How do | run the advanced mode of the FWUT?

A8. Openthe DOS CMD Prompt window.
Go to the directory (shown).
Type in the command Firmwar eUploadGUI .exe /advanced true.

s2cd BOSCH

"Fivmware Upload Tool"

irmvare Upload ToolXFireearelploadGUL.ex vanced trues

ad Tool>FireearelploadGUl .exe iced trae

G wProgran FilessBOSCHOHHEOSFirnware Upload ToolX
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Q9. Why do | see numberslike 2050, 2049, and 2070 on the FWUT Tabsinstead of the OKI, OMI, and OKP?

A9.

FWUT discovers devices using Bosch DNS-SD service. The discovered devices and their names are
displayed as Model 1D’s of the devices. For more information on Model ID, see Table 2 on page 6.The
user defined names are displayed based on the firmware upgrade .capfw files. The .capfw files should be
present as defined in the following path.

Click File | Options
The Firmware Upload Tool Options window appears.

View Help

Options...
Exit  Alt+Fd4

Devices

q Bl
v oo D ==

Finmware images

(LS E  Furnware \V6. 1 10\OKP | Change

V| Inchude sub folders
Uploading
Maximum number of concurrent uploads |20

| Uss sacure conmection

Securty key defaul

Q10. What happensif the Firmware Upgrade processis interrupted because of one of the following two

conditions?
* Network Disconnection
e Accidental shutdown of devices
A10. All RTSSOMNEO devicesimplement afail-safe mechanism. After timeout, the FWUT displaysaFailed

status. The devices themselves reset and reboot to the previous version or if they are in the boot |oader
mode, they stay in the boot loader mode. The recovery options are shut down the FWUT and reopen it,
so that the devices are discovered again. Send the upgrade files again.

Q11. What isOMI-Controller and OMI-Audio Device? How do | upgrade them?

All.

The OMI 10 card has two upgradable components — OMI-Controller and OMI-Audio Device. These
components have different roles and communicate internally with each other over the SPI bus.

The OMI-Controller manages the Intercom functionality and audio routes.

The OMI-Audio manages al the audio.

18



Q12. The OMI-Controller version isdifferent from the Audio device version, how do | syncit?

Al2.

e

o0k

The ssimplest way is upgrade/downgrade the Audio Device version to that of the OMI-Controller. The
stepsto do thisisasfollows.

Open the FWUT.

From the File menu, select Options and then select theimage folder path which contains only the
OMI_AudioDevice<version>.cap.

Click OK.

The OMI-Audio Device tab appears.

Select the OM 1 device for which there is a mismatch.

Click the Upgrade button.

Click the Send button.

Once the upgrade is successfully completed, both versions are synced.

Q13.1 have selected OM | -Firmware .capfw, the controller is showing new version on AZEdit/I PEdit but the
FWUT stills shows updating?

Al3.

Asmentioned earlier OMI has 2 components OMI-Controller and OMI-Audio Device, the FWUT
upgrades the OMI-Controller first. Once the OMI-Controller is updated, the OMI card resets. The FWUT
reconnects with the OMI card and then starts the upgrade of the OMI-Audio Device. Till the OMI-Audio
device upgrade is not completed the FWUT will show as updating.

Q14. 1 have selected OMI-Firmwar e.capfw, the upgrade was successful but only Audio Device got updated
and not the OMI-Controller?

Al4.

The primary reason for thisis the SetupOMNEONI osFirmware64.msi is not installed. Verify the OMI
Plug-in files are correctly installed. For more information, see “Firmware Upgrade Files’ on page 6.
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Q15. 1 haveinstalled all the FWUT packages correctly, still I do not see any devices
A15. Check if the Bosch DNS-SD serviceisinstaled. If installed, isit running?

To verify the Bosch DNS-SD, do the following:

1. Veify the Bosch DNS-SD files are available in the folder: C:\Program Files\ BOSCH\DNS-SD.
2. Verify the Bosch DNS-SD service status is displayed as Started.

1 o e -« e

File Action View Help
|| #2EEd= BHE » nuwn
& Computer Management (Local . Services Actions
a |f} System Tools G DNS"SDS . i - i i . i Vet . | -
(D Task Scheduler ervice ame escription  Status tartup Type  Log On As £
Event Viewer . ActiveX Installer (Adnstsv) Provides Us... Manusl Local Syste... ‘ More Actions »
Stop the service ; : : :
4] Shared Folders e . Adaptive Brightness Menitors a.. Manual Local Service e "
& Local Users and Graups ; Adobe Acrobat Update Service Adobe Acro... Started  Automatic Local Syste... E
(&) Performance  Adobe Flash Player Update Service This service .. Manual Local Syste... Mere Actions 4
& Device Manager Deseription: . Adobe Genuine Software Integrity Service  Adobe Gen...  Started  Automatic Local Syste...
4 3 Storage Offers DINS:SD spiviee: i AeXAgentSrvHost Provides th... Manual Local Syste...
=1 Disk Management 7, AltirisAgentProvider Provides Wi... Manual Local Syste...
4 [ Senvices and Applications /. Application Experience Processesa.. Started  Manual Local Syste...
4 Services Application Identity Determines ... Manusl Local Service
& WMI Control . Application Information Facilitatest... Started  Manual Local Syste...
; Application Layer Gateway Service Provides su... Manusl Local Service
 Application Management Processes in. Manual Local Syste..
ASP.NET State Service Provides su... Disabled Network S...
 Background Intelligent Transfer Service  Transfersfil..  Sterted  Automatic (D... Local Syste..
 Base Filtering Engine TheBaseFil.. Started  Automatic Local Service
' BitLocker Drive Encryption Service BDESVC hos... Started  Manual Local Syste...
BitLocker Management Client Service BitLocker M. Started  Automatic Local Syste...
 Block Level Backup Engine Service The WBENG... Manual Local Syste...
' Bluetooth Device Monitor Aprocesst.. Stated  Automatic (D.. Local Syste..
% Bluctooth Media Service ProvidesBl.. Started  Automatic (D... Local Systc..
Bluetooth OBEX Service ProvidesBl.. Stated  Automatic (D Local Syste..
5  Bluctooth Support Service The Blugtoo... Started  Manual Local Service
i Bosch DNS-SD Service OffersDNS-... Started  Automatic Local Syste...
 Bosch NeighberDiscovery Service OffersNeig.. Started  Automatic Local Syste...
BranchCache This service .. Manusl Network S...
 Broadcom Management Agent Menitors an... Started  Automatic Local Syste...
; Certificate Propagation Copies user ... Manusl Local Syste...
 Cisco AnyConnect Secure Mobility Agent  Cisco AnyC... Sterted  Automatic Local Syste..
CMST Service CMST Service  Started  Automatic Local Syste...
 CNG Key Isolation The CNG ke.. Started  Manual Local Syste...
% COM+ Event System SupportsSy.. Started  Automatic Local Service
1 COM-+ System Application Manages th... Manual Local Syste...
Computer Browser Maintains . Manual Local Syste...
% Configgr Task Sequence Agent ConfigMgr ... Manual Local Syste...
; Configuration Manager Remote Control  Provides th... Disabled Local Syste...
Credential Manager Provides se... Manual Local Syste.. o
4 i v | Extended / Standard /

Q16: The OMI card Version string shows Hardware Failure? Isthe OMI card not working?

A16: No, thismeansthat OMI-Controller is not able to communicate with the OMI-Audio Device. Thiscould
be because of Version Mismatch, mismatch of 1P address of OMI-Controller and OMI-Audio Device.
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